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Chapter 1
Try It! ZoomBrowser EX Starting ZoomBrowser EX (1/4)

This chapter covers the ZoomBrowser EX basics, such as starting the
program, downloading images from the camera and printing them. It
begins with the procedures for starting the program.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• This guide assumes that all the relevant software programs and
drivers have been correctly installed on your computer. If they
have not been installed yet, read the guides that accompanied
your camera and install them before proceeding further.

Starting Methods

There are two ways to start ZoomBrowser EX: “Starting by
Connecting the Camera to the Computer” and “Starting by
Clicking an Icon or Menu.”

It is generally easier and more convenient to start it by
connecting the camera to the computer.

However, you may wish to click an icon or menu to start it
under the following circumstances.
• When you are using a memory card reader.
• When you wish to use ZoomBrowser EX without connecting a

camera.
• When you are restarting ZoomBrowser EX with the camera

still connected after the program has been closed once.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• With some versions of Windows, you may not be able to use
the “Starting by Connecting the Camera to the Computer”
method the very first time the camera is connected to the
computer after it is booted up (owing to a limitation of Win-
dows). In this case, start ZoomBrowser EX with the “Starting by
Clicking an Icon or Menu” method. You may use the camera
connection method from the second time onward.
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Chapter 1
Try It! ZoomBrowser EX Starting ZoomBrowser EX (2/4)

Starting by Connecting the Camera to the Computer

You can start ZoomBrowser EX with this method by attaching
the camera to the computer and preparing it to transfer data.
Set the following Auto Start Settings the first time (only) that
you connect the camera to a computer. If you have already set
them, proceed to the steps on the next page.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• This method can only be used when the camera is connected to
the computer with the interface cable.

■  Settings for the First Connection to a Computer

1. Use the interface cable to connect the camera to the
computer.
Please see the manual supplied with your camera for
connection instructions.
With some models, the camera may need to be set to the
playback mode to communicate with a computer. Consult the
manual for these models to set the camera to the correct mode
for communication.

A dialog similar to the following one (Events dialog) will appear.
If it does not, read the Troubleshooting section in the
Appendices.

2. Select [Canon CameraWindow] and click [OK].

3. Click [Set].
Once you click the Set button, this dialog will no longer appear
when the camera is connected.

Your camera model name or
“Canon Camera” will appear here.

The dialog for Step 1 shown on the next page will now appear.
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Chapter 1
Try It! ZoomBrowser EX Starting ZoomBrowser EX (3/4)

■  Procedures for Subsequent Connections to a Computer

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• With some versions of Windows, you may not be able to use
this method of starting ZoomBrowser EX the very first time the
camera is connected to the computer after it is booted up. (The
dialog shown to the right will not display even if you connect
the camera to the computer correctly.)
In this case, start the program with the Starting by Clicking an
Icon or Menu method.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If the Scanners and Cameras Wizard displays, close it and use
the Starting by Clicking an Icon or Menu method to start
ZoomBrowser EX.

• A device selection dialog will display if you have both a camera
and a memory card reader connected at the same time. Confirm
that your camera model name or [Canon Camera] appears in
the list box and click [OK].

The procedures from this point onward are described in the
next topic, “Downloading Images to a Computer”.

Click [Browse Images with ZoomBrowser EX] if you wish to
proceed to ZoomBrowser EX’s main window and do not wish to
download images.

The explanation about which method is used to download
images after ZoomBrowser EX starts up automatically is
contained in the “Auto-Download Settings” section of the
Appendices.

1. Use the interface cable to connect the camera to the
computer.
Please see the manual supplied with your camera for
connection instructions.
With some models, the camera may need to be set to the
playback mode to communicate with a computer. Consult the
manual for these models to set the camera to the correct mode
for communication.

A dialog like the ones below will display.
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Chapter 1
Try It! ZoomBrowser EX Starting ZoomBrowser EX (4/4)

Starting by Clicking an Icon or Menu

Use the following methods to start ZoomBrowser EX using its
desktop icon or a menu.

■  The Icon Method

1. Double-click the [ZoomBrowser EX] icon on the desktop.

ZoomBrowser EX will start and open its main window.

The procedures for downloading images are described in the
next topic, “Downloading Images to a Computer.”

■  The Menu Method

1. Click the [Start] menu and select [All Programs] or
[Programs], followed by [Canon Utilities],
[ZoomBrowser EX] and [ZoomBrowser EX].
ZoomBrowser EX will start and open its main window.

Main Window

The procedures for downloading images are described in the
next topic, “Downloading Images to a Computer.”

Main Window
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Chapter 1
Try It! ZoomBrowser EX Downloading Images to a Computer (1/4)

This section describes two methods for downloading images shot with
a camera to a computer.

■  Downloading Images with Computer Commands
This method uses commands entered on the computer to
download images from a memory card in a camera or in a
memory card reader. This method can be used regardless of
whether your camera supports the direct transfer function or not.

■  Downloading Images with Camera Commands
You can use this method to download images with cameras
that support the direct transfer function.

Check to ensure that the computer and the camera or memory
card reader are in the correct state for communication.

Using Computer Commands to Download Images

1. Read the dialog that displays.
If a dialog similar to the one below appears, proceed to Step 4.

Proceed to Step 2 if ZoomBrowser EX’s main window displays.

2. Click [Camera & Memory Card].

If you are using a memory card reader, check to ensure that the
card is correctly inserted in the reader.

3. Click [Browse & Download Images].

* The dialog will vary
slightly according to
your camera model.
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Chapter 1
Try It! ZoomBrowser EX Downloading Images to a Computer (2/4)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• A dialog will appear if multiple memory card readers are con-
nected and loaded with memory cards, or if a camera and a
memory card are connected concurrently, to allow you to select
which images are shown from which device. In that case, select
the desired device from the list box and click [OK].

4. Click [Start Image Download].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can view information such as the destination folder for
images by clicking [Show Current Settings] in the window.

• By the default setting, the program downloads all the images
that have not yet been downloaded.

The images will begin to download. The downloaded images
will be saved into folders according to their creation dates.
When the download is complete, the downloaded images will
appear in the main window.

Downloaded images
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Chapter 1
Try It! ZoomBrowser EX Downloading Images to a Computer (3/4)

Using Camera Commands to Download Images

You can download images using camera commands if your
camera supports the direct transfer function (camera has a
Print/Share button ).

1. Read the dialog that displays.
If a dialog similar to the one below appears, proceed to Step 2.
The Print/Share button will light up at this point and a direct
transfer menu like the one shown at the lower right will appear
in the camera’s LCD monitor.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• The camera’s Print/Share button cannot be used to download
images if it is not lighted.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The dialog in step 1 will not display if the Camera Window or
RemoteCapture Task window is open. Please close these win-
dows.

• A dialog will appear if a camera and a memory card reader are
connected concurrently to allow you to select the device from
which images are shown. Select the desired device from the list
box and click [OK].
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Chapter 1
Try It! ZoomBrowser EX Downloading Images to a Computer (4/4)

2. The image transfer will commence after you set the
direct transfer setting on the camera.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See the Camera User Guide for the settings and procedures
related to the Direct Transfer menu shown on the camera’s LCD
monitor.

• You can also download images by clicking the [Start Image
Download] button on the program window on the computer
instead of clicking the camera’s Print/Share button.

• You can view information such as the destination folder for
images by clicking [Show Current Settings] in the program
window on the computer.

• By the default setting, the program downloads all the images
that have not yet been downloaded.

The images will begin to download. The downloaded images
will be saved into folders according to the shooting date.
The images will display in the main window when the
download is complete.

Downloaded images
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Chapter 1
Try It! ZoomBrowser EX Printing Images (1/6)

You will use the PhotoRecord printing utility to print.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Images recorded in the Adobe RGB color space will appear
unsaturated when printed using PhotoRecord. (Color space
settings are only available on select camera models.)

• Please see the PhotoRecord Help menu for more details on using
this program.

1. Click [Print].

2. Click [Layout Print] in the next menu.

3. Select the images you wish to print and click [Next].
The background of the selected images will turn orange.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• More than one image can be selected by clicking on successive
images. To deselect an image, click it a second time.
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Chapter 1
Try It! ZoomBrowser EX Printing Images (2/6)

4. Place a check mark in the boxes of the data you wish to
include with the print (multiple selections are possible)
and click [Finish].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See Viewing Image Properties in Chapter 4 to learn how to
append comments to images.

This will start PhotoRecord and display the print image in the
album window.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If the PhotoRecord Guide displays at startup, read it as neces-
sary.

To operate PhotoRecord, follow the procedures displayed at the
window’s left.

The Steps in Order Album Window
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Chapter 1
Try It! ZoomBrowser EX Printing Images (3/6)

5. Click [2 Select Printer & Album Type] and select a
printer and an album type.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Select among the following album types.

• Album—Booklet
Arranges pages with a margin for binding multiple printed
pages together and white spaces at the left or top.

• Album—Simple Album
Creates margins of equal size at the top, bottom and sides.

• Other—Contact Sheet
Prints the images in a table format.

• Other—One Photo Per Page
Prints one image on each page.

• Other—Fixed Size Photo
Prints images at a set size.

• Other—Mosaic
Prints a specified number of images in a spread.

• After you have selected the album type, you can set the detailed
parameters for each album type in the area below, such as the
margin placement and width and the number of images in an
arrangement.

Detailed settings for each album type

Select an album type

Select a printer
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Chapter 1
Try It! ZoomBrowser EX Printing Images (4/6)

6. Click [3 Select Paper] and choose the media type,
paper size and paper orientation.

Media Type and Paper Size Settings

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The settings categories shown in this window may vary accord-
ing to the printer in use.

7. Click [Decorate Album] and change the image back-
ground, frame and other design elements as desired.

Select an item to change

Select a design

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The items that can be changed include the themes (a unified
design for the background, photo frames and text frames, etc.)
backgrounds, photo frames, text frames, and clip art.

• Select the target page, image or text first when choosing a
background, photo frame or text frame.
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Chapter 1
Try It! ZoomBrowser EX Printing Images (5/6)

8. Click [Add Titles & Captions] and change or add titles
and text as desired.
Click on text that is already displayed to change it.

To add new text, click the target page and input the text.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also adjust the font, font size, justification and color as
desired.

Select the text.

Edit it here.

Select the page

Input the text
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Chapter 1
Try It! ZoomBrowser EX Printing Images (6/6)

9. Change the size and rotation angle of the image, text
or clip art as desired.
The following operations can be performed in the album
window.

■  Move Items

You can move images, text or clip art by dragging them.

■  Change Size or Rotation Angle
You can change the size or rotation angle of images, text or clip
art by dragging the following points on them.

10.Click [4 Print], confirm the number of copies and
other print settings and click [Print].

Sets it to the state at the right
(rotation mode).

You can change the
size by dragging
one of these points.

Sets it to the state at the left
(sizing mode)

You can change the rotation
angle by dragging this point.

This starts the printing process.

To close PhotoRecord, click the  (close box), or click the [File]
menu and select [Exit].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Images captured by cameras that support the Exif 2.2 standard
(nicknamed the “Exif Print” function) have the shooting settings
data, such as the shooting conditions and shooting mode,
embedded in them. You can obtain better prints by using this
data to correct and print the images.

• PhotoRecord automatically performs image correction (default
setting) on images shot by cameras that support the Exif 2.2
standard and on other image types, providing you with better
print results.
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Chapter 1
Try It! ZoomBrowser EX

In this section, we explain information that you should know to use
ZoomBrowser EX.

If You Have a Problem

ZoomBrowser EX comes with a Help file. Use it when you want
to learn how to do an operation, or when you want to know
about the features of the program.
You can access Help from the [Help] menu or the [?] (Help)
button.

Exiting ZoomBrowser EX

You can exit ZoomBrowser EX by clicking  (Close button) on
the Browser Window. Alternatively, select [Exit] from the [File]
menu.

Supplementary Information

Help menu

Help button
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Chapter 2
What is ZoomBrowser EX? What Can ZoomBrowser EX Do?  (1/2)

This chapter explains the basic skills required to master ZoomBrowser EX.
Let’s begin with an overview of the main features.

Connect the camera to your computer to:

• Download images from the camera to your computer in an
easy procedure.

• View an index of the images from the camera on the
computer monitor.

• View information (shooting date and camera settings) about
images stored in the camera.

• Use your computer to set up slide shows or DPOF print
settings (not available on some models).

• Save computer images onto your camera.
• Operate the shutter of a camera connected to a computer via

an interface cable to take pictures remotely, or to perform
interval timer shooting after specifying an interval and the
number of images to be taken (only on models supporting
remote shooting).

• Convert RAW format images (change them to the TIFF or
JPEG format and resave them). Adjust the brightness,
contrast, color and other settings as you convert them. (Some
camera models do not support RAW images.)

Use the file management features to:

• Categorize, sort and manage image files on your computer
with easy procedures.

• Move or copy images.
• Perform simple editing such as cropping images or adjusting

their colors.
• Create and edit movies, adding various effects: link movies

and still images, superimpose titles and other text, and add
background music.

• Run a slide show displaying the images in sequence in the
full-screen mode.

Use the My Camera Settings function to:

• Save the My Camera Settings in the computer to the camera
or vice versa.

• Handle newly created images and sounds as My Camera
Settings.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The start-up image, start-up sound, shutter sound, operating
sounds and self-timer sound are collectively called the My
Camera Settings.

• The Canon CD-ROM supplied with your product contains several
prepared My Camera Settings files. These files are automatically
copied to your computer when you install ZoomBrowser EX.
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Chapter 2
What is ZoomBrowser EX? What Can ZoomBrowser EX Do?  (2/2)

By using other programs:

ZoomBrowser EX gives you additional power when you use it
together with the following programs. (You can start these
programs from within ZoomBrowser EX.)

■ PhotoRecord

• You can use this program to create and print beautiful
layouts consisting of multiple images.

• You can select frames and backgrounds with a variety of
designs.

• You can add text to images or pages.
• You can create original image albums.

■ PhotoStitch
• You can stitch multiple images (which were split and shot

individually using functions like the camera’s Stitch Assist
mode) together to form a single, large size, panoramic picture.

• You can stitch images horizontally or vertically.
• If you shoot the surroundings in 360 degrees, you can later

stitch the images to form a 360-degree cylinder. By saving
this stitched image in QuickTime VR format, you can then get
a virtual view of the various parts of the image.
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Chapter 2
What is ZoomBrowser EX? Finding Images and Folders (1/2)

It is important to understand how folders are used in ZoomBrowser EX
to store images.

Where Are Images Stored?

Use the following procedures to find out where image files are
stored on your computer when they are downloaded from the
camera.

1. Click the Windows [Start] menu and select [My
Pictures].
Windows 2000/Windows Me/Windows 98 users should double-
click the [My Documents] folder, followed by [My Pictures].

The images that you downloaded in Chapter 1, Downloading
Images to a Computer, should be contained in the My Pictures
folder. As you will note, the folders mentioned above also
appear at the right of the ZoomBrowser EX window.

If you double-click the folders appearing in the Windows screen
shot at the left, you will find image files and folders with the
same names as those displayed in the ZoomBrowser EX
window.

As this demonstrates, when you open a particular folder in
ZoomBrowser EX and download images to it, or move images
between folders, these changes are also happening in the
corresponding folders shown by the Windows operating
system.
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What is ZoomBrowser EX?

Folders in the Browsing Area and Folder Area

Image thumbnails (tiny versions) are shown in the right-hand
side of the ZoomBrowser EX window. This area is called the
Browsing Area. The area in the middle, called the Folder Area,
shows the folder directory much as it is shown in Windows
Explorer.

The Folder Area shows all the folders on the computer. The
orange colored folder is the currently selected folder. The
images inside this folder are what are shown in the Browsing
Area.

Folder Area Browsing Area

Folders within Folders

You can create folders within folders, adding successive levels
to provide detailed categories that make it easy to find and use
your images.

Example of folders within folders
for categorizing images

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Instructions for creating folders are included in Chapter 4.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• In ZoomBrowser EX 4, image files in folders within the Program
Files folder (saved using ZoomBrowser EX 2 or 3) will not display.
To display these images, follow the procedures in If You Were
Using ZoomBrowser EX Version 2 or 3 of the Troubleshooting (2/
4) section.

Finding Images and Folders  (2/2)
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Chapter 2
What is ZoomBrowser EX? Main Window (1/5)

This window is designed for managing images downloaded to the
computer. It can also be used for various functions, such as printing and
sending images by e-mail.

Main Window Components

Switching to the Camera Window

To switch to the Camera Window, click the [Camera & Memory
Card] task button, followed by [Browse & Download Images] in
the next menu.

Path of the selected folder
(word string describing the location)

Function Buttons
Buttons that perform various
functions on the images in the
Browser Area.

Browsing Area
Displays the image thumbnails (tiny
versions) and folders contained
within the folder selected in the
Folder Area.

Folder Area
Displays all the folders in
the computer. Use this area
to select folders that
contain images.

Task Area
Contains the buttons for
frequently used tasks.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Images recorded in the Adobe RGB color space will appear
unsaturated when displayed in ZoomBrowser EX. (Color space
settings are only available on select camera models.)
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What is ZoomBrowser EX?

Task Area and Task Buttons

The Task Area contains the four task buttons: Camera &
Memory Card, Print, View & Modify and Internet. Click one of
these buttons to perform the related task.

■ Camera & Memory Card

Click this to open the Camera Window or perform remote
shooting.

■ Print
Click this to print images.

■ View & Modify
Click this to display images in a slide show or edit them.

■ Internet
Click this to attach images to e-mail messages.

When you click one of these buttons, the corresponding
submenu to the right displays.

Main Window (2/5)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To return to the main window, click [Return to Main Menu] at
the bottom of the menu.

• To switch from one task to another, click the appropriate icon

        to the right of the task button.
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Chapter 2
What is ZoomBrowser EX?

Using the Task Windows

When you select a task from the menu, all of the steps in that
task display in the task area.

■ Orange Button
This color marks the current step. Follow the instructions in the
right-hand side of the window to proceed. When you have
completed the step, click the [Next] or [Finish] button at the
bottom right of the window to proceed to the next step.

Main Window (3/5)

■ Gray Buttons
Tasks that are selectable at the time are colored gray. The button
turns dark gray when the mouse cursor is placed over it. You
can switch between tasks by clicking another task button.
However, if you have already finished selecting an image and you
switch to the [Select Captions for Printing] task, you must click
[Select Images] again to reselect the image.

■ Grayed Out Buttons
Grayed out buttons indicate tasks that are not available at the
time. When you finish the task underway, the buttons will once
again become selectable.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Click [Previous] to return to the prior step.
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Chapter 2
What is ZoomBrowser EX?

Function Buttons

The following buttons are available in the main window.

Zoom-In Button (zoom mode only)
Zooms in on images or folders in the Browser Area.

Zoom-Out Button (zoom mode only)
Zooms out from images or folders in the Browser Area.

Up Button
Advances one step up from a lower level folder.

Select All Button
Selects all the images and folders in the Browser Area.

Clear All Button
Deselects any images or folders selected in the Browser
Area.

Chapters 3 and 4 explain more about the task and function
buttons.

View Mode Button
Switches between the zoom mode, scroll mode and
preview mode according to the context.

Thumbnail Size Button (scroll mode only)
Selects the size of images displayed in the Browser
Area.

View Image Button
Displays the selected image at a larger size in the View
window.

Properties Button
Displays information about the selected image.

Rotate Button
Rotates the selected image. Choose between 90° left,
90° right or 180°.

Delete Button
Deletes the selected image from the computer.

Main Window (4/5)
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Chapter 2
What is ZoomBrowser EX?

Changing the Display

You can hide the Task Area and Folder Area to make the
Browsing Area larger.

■ Hiding the Task Area
Click the  button in the upper right of the Task Area to hide
it and make the Browsing Area larger. Click the  button to
redisplay the Task Area.

Main Window (5/5)

■ Hiding the Folder Area
Click the  button in the upper right of the Folder Area to
hide it and make the Browsing Area larger. Click the  button
to redisplay the Folder Area.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also hide the Task Area by clicking the [View] menu,
selecting [Task Area] and removing the check mark beside it.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also hide the Folder Area by clicking the [View] menu,
selecting [Folder Area] and removing the check mark beside it.

• Both the Task Area and Folder Area can be hidden at the same
time.
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Chapter 2
What is ZoomBrowser EX? Camera Window (1/2)

The Camera Window is used to view images contained in the camera
(memory card) and to select and download images to a computer.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Images recorded in the Adobe RGB color space will appear
unsaturated when displayed in ZoomBrowser EX.  (Color space
settings are only available on select camera models.)

• Methods for displaying and using the Camera Window are
explained in Chapter 5.

Camera Window Components

Task Area and Task Buttons

The Task Area contains the four task buttons: Download
images, Print, View as slideshow and Connect to internet. Click
one of these buttons to perform the related task.

■ Download Image

Downloads the selected images to the computer.

■ Print
After the selected images have been
downloaded to the computer, this button starts
the printing process. A submenu like the one to
the right appears when you click this button.

■ View as Slideshow
After the selected images have been downloaded to the
computer, this button starts an automated slide show.

■ Connect to Internet
After the selected images have been
downloaded to the computer, this button starts
the process for creating e-mail attachments. A
submenu like the one to the right appears when
you click this button.

Close button
Click  to switch back to the
main window.

Task Area
Contains buttons for
frequently used tasks.

Function Buttons
Buttons that perform various functions on the
images in the Camera Window.
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○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To switch from one task to another, click the appropriate icon

       at the right of the task button.

Function Buttons

The following buttons are available in the Camera Window.

Select Button
Selects images for further processing with other
functions. Various selection methods can be chosen
from the submenu.

Deselect Button
Deselects a selected image.

Rotate Button
Rotates the selected image. Choose between 90° left,
90° right or 180°.

Delete Button
Deletes the selected image from the camera (memory
card).

Properties Button
Displays information about the selected image.

Help Button
Displays the help dialog.

Chapter 5 explains more about the task and function buttons.

Set Button
Sets various settings, such as those for connecting to a
camera. The following items are included in the
submenu.
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Chapter 2
What is ZoomBrowser EX? Using the Right-Click in Operations

With ZoomBrowser EX you can access many useful functions by using
the right mouse button (right-click).

For example, if you right-click a thumbnail, the following
shortcut menu appears.

Right-click anywhere on the image to display a shortcut menu.

A shortcut menu is a convenient collection of the most
common window buttons and menu commands that apply to a
given situation.

The right-click allows you to use ZoomBrowser EX more
efficiently. After you become familiar with ZoomBrowser EX, try
right-clicking in many situations and you will be impressed with
its convenience.

Note that, in general, this manual does not cover operations
using the right-click. (This is because explaining many shortcut
menu variations would take too many pages of this manual.)
However, there are a few operations that are only accessible by
right-clicking. These operations are described on the
corresponding pages.
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Chapter 3
Viewing Images

This chapter explains how to view and edit images in ZoomBrowser EX.
In this section, you will learn how to use the Folder Area to select
folders with images that you wish to view.

Selecting Folders

Click a folder in the Folder Area to view its contents in the
Browsing Area.

Selecting Folders - Folder Area

Collapsing and expanding a folder

If a folder contains subfolders, you can use the  and 
buttons to collapse or expand the folder. When you click the 
button to collapse the folder, its subfolders are hidden. When
you click the  button to expand the folder, its subfolders are
displayed.

Images from the selected folder display (if there
are folders within the selected folder, those
folders and their images are shown within a
folder-shaped border).

Selected folder

Click  to collapse a folder. Click  to expand a folder.
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Chapter 3
Viewing Images

This section explains how to use the Browsing Area to open folders and
search and view images.

Selecting a Display Mode

The Browsing Area features three display modes: the zoom
mode, scroll mode and preview mode. The zoom mode is the
default mode. To switch between modes, click  (View Mode)
and choose an option from the menu that appears.

Selecting Folders - Browsing Area (1/5)

Images within nestled
folders also display (a
folder-shaped border
indicates a subfolder).

■  Zoom Mode
Zoom mode displays all the images in subfolders as well as the
selected image folder.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also switch between display modes by clicking the
[View] menu and selecting one of the scroll mode, zoom mode
or preview mode options.

• In scroll mode, you can change the image thumbnail size by
clicking the  (Thumbnail Size) button (or by clicking the
[View] menu and selecting [Thumbnail Size]) and selecting a size
from the menu.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The procedures for changing the zoom speed are explained in
the Customizing Preferences (1/3) section of the Appendices.

• It can be difficult to find a particular image when you have a
multitude of folders and images. In this situation, you can use
the Zoom mode to find a particular image by viewing all the
folders and picking the most likely one to contain it.
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Scroll Bar

Images in subfolders
do not display.

■  Scroll Mode
Scroll mode only displays the images in the selected image folder
to show them at a larger size. A scroll bar will appear on the right
side of the Browsing Area if all the images do not fit at once. If the
image folder contains subfolders, only their icons display.

Selecting Folders - Browsing Area (2/5)

■  Preview Mode
This mode displays one image at a large size and information
about the image.
Select the image to preview from the bottom of the Browsing
Area. You can also switch between preview images using the
[Next] and [Previous] buttons.

Displays various
image information

Images within the
folder do not display

Click an image to preview
it at a larger size

Switches between the
next and previous images
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Selecting Folders

■  Zoom Mode
In the Browsing Area, double-click an area where there is no
image inside the folder you wish to see. The contents of the
folder are displayed in the Browsing Area.

■ Scroll Mode
In the Browsing Area, double-click the icon of a displayed folder
to view its images and subfolders.

Double-click inside the
desired folder to zoom
in on its contents.

Double-click a folder
to view its contents.

If a folder icon is not shown on the
screen, click the scroll bar to display it.

Selecting Folders - Browsing Area (3/5)

By repeating this step, you can go deeper and deeper into the
folder hierarchy.

By repeating this step, you can go deeper and deeper into the
folder hierarchy.
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Viewing Images Selecting Folders - Browsing Area (4/5)

Click the [Up One
Level] button to
zoom out the folder
at that level.

Returning to a higher level in the folder hierarchy

When you are deep in the folder hierarchy, you can use the 
(Up) button to go back to a higher level.

The example below shows the zoom mode, but the procedure
is the same for the other display modes.

■ Preview Mode
At the bottom of the Browsing Area, double-click the icon of a
displayed folder to open it and view its images and subfolders.

By repeating this step, you can go deeper and deeper into the
folder hierarchy.

Double-click the folder
icon to display its
images and then click
on one to preview it.
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Viewing Images Selecting Folders - Browsing Area (5/5)

Double-click this area to
skip the Samples folder
and zoom in directly on
the Flower folder.

In Zoom mode, you can do this

There are more convenient ways to use the Zoom mode.

■ Zooming in by skipping levels
You can zoom in directly on a subfolder displayed in the Browsing
Area without going through each successive level by double-
clicking within the folder (on a point containing no images).

■ Using the Zoom-In or Zoom-Out Cursor
Click  in the function buttons to change the mouse cursor
into a magnifying glass. You can then zoom in on a folder or
image in the Browsing Area by clicking it with this cursor. Click
the  button to zoom out.

■ Right-Clicking to Zoom In or Out
Right-click on any clear area in the Browsing Area to display a
menu like that below. You can zoom an image or folder in or
out by selecting the respective [Zoom In] or [Zoom Out] option
from this menu.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can get the same result by using the [View] menu. Click a
folder. Then, on the [View] menu, click [Zoom In] or [Zoom Out].
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This section explains how to open images displayed in the Browsing Area.

How to open an image

In the Browsing Area, double-click the image that you want to
open. The image appears in a new window.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• After selecting an image, you can click  (View Image) to open
the image.

• You can also open an image by selecting it, clicking the [View]
menu and selecting [View Image].

Opening multiple images

Continue to double-click successive images or hold down the
[Shift] key while you click on successive images. Then click 
(View Image) to open all the images simultaneously.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• A confirmation dialog will display if you attempt to open more
than five images at one time.

Closing an image

Click  (Close button) on the image window to close the
image.

Double-click the image
you want to see.
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This section explains how to zoom an image.

How to select a zoom ratio

Click the  at the bottom of the window to open a submenu
and click an option to change the display to that zoom ratio.

Zooming

Scaling to the window size

You can scale the image to fit the window size. From the zoom
ratio list, click [Scale to Fit]. The image is adjusted to the size of
the window.

Typing a zoom ratio

You can display an image at a ratio you set by typing a value in
the zoom ratio box and pressing the [Tab] or [Enter] key.

Choose a zoom ratio from
the list.

The mouse cursor changes to an arrow when you place it
here. Click and drag in this state to change the window size.

Enter a value (%) and press the [Tab] or [Enter] key.
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This section explains how to edit an open image.

Edit Panel Features

An edit panel for revising images displays beneath images that
have been opened.

Editing Images (1/4)

Using the edit panel, you can perform the following editing
operations.

■ Crop
Crop the image, cutting out parts that are not needed.

■ Color, Brightness, Contrast
Change the image appearance by adjusting color density,
brightness, and contrast.

■ Undo, Redo
Undo or redo the previous editing operation. This allows you to
try various changes until you are satisfied with the image.

■ Save As
After you have modified an image, you may want to save it
under a different name. This function allows you to do so.

See the following pages for detailed descriptions of these
functions.

Edit Panel
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Drag within the frame
to adjust position of
the frame.

Drag the anchor points
■  to adjust the size of
the area for cropping.

A Drag to frame the area
for cropping.

B Click this
button.

■ Crop
Use this function to extract only part of an image, leaving out
unneeded portions.
Place the mouse pointer within the image you want to crop.
Click and drag to form a rectangular frame. Then, click 
(Crop) to extract the area within the frame.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can drag any of the anchor points ■  located along the
frame to adjust the size of the area for cropping. Also, if you
want to change the position of the whole frame, place the
mouse pointer within the frame and drag it.
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Increase contrast

Increase color saturation

Increase brightness

Decrease contrast

Decrease color saturation

Decrease brightness

Color, Brightness and Contrast

You can adjust the color (saturation), brightness or contrast by
dragging the respective slider in the edit panel.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can adjust the color (saturation), brightness and contrast by
entering a value in the box beside the slider and pressing the
[Tab] or [Enter] key.
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Click this button.

Undo, Redo

After you edit an image,  the result may not satisfy you and you
may want to go back to the previous step. In this case, click 
(Undo) to cancel the operation and return to the previous step.
Keep clicking  (Undo) to continue going back. If you feel
that you have undone too many steps, you can reverse it by
clicking  (Redo).

Save As

After you have modified an image, you can save it under a
different name so that the original image remains intact.
Click [Save As] to display the Save As dialog. Type a new name
and specify the kind of file and the image quality. Then, click
[Save].

Overwriting the original image

After you have modified an image file, you can save it under
the same file name (overwriting the original image). In this
case, click [Save As]. When the Save As dialog box appears,
type the same name as the one of the original image. (To find
out the name of the original image, check the title bar of the
image window.)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• After you have modified an image, if you click  (Close button)
without saving the changes, a message appears to prompt you
to save the edited image.

To save the changes, click [Yes]. When the Save As dialog box
appears, type a name and specify the kind of file and the image
quality. Then, click [Save].
If you do not want to save the changes, click [Cancel].

Editing Images (4/4)
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This section explains how to edit an image selected in ZoomBrowser EX
using another image editing program that has been registered with
ZoomBrowser EX.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If you installed the image editing program included with your
product (contained on a CD-ROM other than the Solution Disk),
it should automatically be registered in the ZoomBrowser EX
menu.

• The procedures for registering programs are included in the
Image Editor Tab section of the Customizing Preferences (2/3)
topic in the Appendices.

Editing Images with Other Programs

How to edit an image with other programs

Click [View & Modify] in the main window, followed by [Edit
Image] in the next menu.

A Select an image.

B Click this.

This will start the image editing program and open the selected
image in it.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• You can also open an image after you have selected it by
clicking the [Edit] menu and selecting [Edit Image].
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This chapter explains how to manage images effectively with
ZoomBrowser EX. It starts with the method for creating a new folder
within an existing one.

Creating Folders

1. Select a folder in the Folder Area.
You will be creating a new folder within the folder selected
here.

2 Click the [File] menu and select [New Folder].

Creating Folders

3. Type a name for the new folder and click [OK].
You have created a new folder.
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This section explains how to select images in the Browsing Area.

Selecting a Single Image

Click on an image to select it. The background color of the
selected image(s) will change to orange.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• To deselect an image, click it again.

Selecting Multiple Images

To select more than one image, continue clicking on successive
images. You can select a series of adjoining images in one step
by holding down the [Shift] key while you click the first and last
images.

Selecting All the Images

Click  (Select All) at the top of the Browsing Area to
select all the images in a single step. You can also click the
[Edit] menu and choose [Select All].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• Click  (Clear All) at the top of the Browsing Area to
deselect all the images at once.

• You can also deselect all the images at once by clicking the [Edit]
menu and choosing [Clear All].

• You can change the selection methods to standard Windows
selection methods. See the Selection Tab topic in Customizing
Preferences (2/3) in the Appendices.



46      ZoomBrowser EX Software User Guide

Chapter 4
Organizing Images

This section explains how to move or copy images between folders. It is
convenient to conduct these procedures in the zoom mode.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• Moving or copying images in ZoomBrowser EX affects the actual
location in which those images are stored on your PC.

Moving an image in the Browsing Area

You can move an image in the Browsing Area simply by using a
drag-and-drop operation.

Moving or Copying Images (1/4)

A Drag the image you
want to move.

B Drop it at the
desired location.
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Copying an image within the Browsing Area

To copy an image, before you drop the image you are dragging,
press and hold the [Ctrl] key and release the mouse button,
while still holding the key.

A Drag the image you
want to copy. B While holding down the [Ctrl] key,

drop it at the desired location.
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Moving or Copying an Image from the Browsing Area to the
Folder Area

You can move or copy images between different folders by
dragging them from the Browsing Area to the Folder Area and
dropping them in the target folder.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• To copy an image from the image folder you are in at the
moment to a different image folder, proceed the same way.
Hold down the [Ctrl] key before dropping the image and release
the mouse button while holding the key over the target library.

Copying by Dragging a File Icon from a Windows Window

You can also copy an image by dragging its file icon from an
open Windows window and dropping it onto the ZoomBrowser
EX window.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• On the other hand, when you drag an image from the Browsing
Area of ZoomBrowser EX to Windows Explorer, the image is
automatically copied.

A Drag the image you wish to move.

B Drop it in the target folder.

A Drag the image
you wish to move.

B Drop it in the target folder.
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Additional ways of moving or copying images

■ Moving or copying many images at once
You can select several images by clicking them in succession.
You can also select a series of adjoining images in one step by
holding down the [Shift] key while you click the first and last
images.
Once the images are selected, you can move or copy them all
together with standard drag and drop procedures.

■ Moving or copying a complete folder
In addition to moving or copying individual images, you can
move or copy an entire folder. In the Zoom display mode, select
the folder by clicking inside it where there are no images. Then
move the folder by dragging and dropping it, or copy the folder
by first pressing down and holding the Ctrl key, and then
dragging and dropping the folder.
Display modes and folder selection procedures are explained in
Selecting Folders - Browsing Area in Chapter 3.

■ Copying from the menu
Select one or more images, click the [Edit] menu and select
[Copy]. Next, select the target folder in the Folder Area, click
the [Edit] menu and select [Paste]. (This operation is not
available with Windows 98.)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• You can select all the folders or images displayed in the Browsing
Area at once by clicking  (Select All) at the top of the
Browsing Area or by clicking the [Edit] menu and selecting [Select
All].

Moving or Copying Images (4/4)
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Click [Yes] when a confirmation dialog like the one below
appears.

This section explains how to delete images that you no longer need.

How to delete an image

Click the image you want to delete, and click  (Delete).

Deleting Images (1/2)

A Click an image. B Click [Delete].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• If you accidentally delete a required image, double-click the
[Recycle Bin] icon on the Windows desktop to open it. Select the
image and, in the Recycle Bin Tasks section, click [Restore this
item]. (With Windows 2000/Windows Me/Windows 98 in web
page view mode, select the image and then click [Restore this
item back to its original location] at the left side of the window.)
When you switch back to ZoomBrowser EX and click the [View]
menu and select [Refresh Current Folder], the image will
reappear in its original location.
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Other ways of deleting images

■ Deleting multiple images
You can select several images by clicking them in succession or
by holding down the [Shift] key while you click the first and last
images in a series. When you have selected all the images that
you want to delete, clicking  deletes all of the selected
images at once.

■ Deleting images from the File menu

Click an image. Then, click [Delete] on the [File] menu to delete
the image.

■ Deleting an Entire Folder of Images
This procedure is explained later in this chapter in the Deleting
Folders topic.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• To completely delete images from the computer after
completing the procedures above, double-click the [Recycle Bin]
on the Windows desktop to open it and, in the Recycle Bin Task
section, click [Empty the Recycle Bin].
(With Windows 2000/Windows Me/Windows 98 in web page
view mode, click [Empty Recycle Bin] at the left side of the
window.)

Deleting Images (2/2)
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This section explains how to rotate images to the desired orientation.
This is useful for images taken by holding the camera sideways.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• By the default setting, rotating an image in ZoomBrowser EX
changes (rotates) the image in the file on your PC.

How to rotate an image

Select an image and click  (Rotate). Select the direction of
rotation in the next menu.

Rotating Images

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• 90-degrees left is a counterclockwise rotation and 90-degrees
right is a clockwise rotation.

• There are two methods for rotating images. With the default
setting, the original image is rotated.

• To set the rotation settings, refer to Rotate Tab of the
Customizing Preferences (3/3) section.

Other ways of rotating images

■ Rotating multiple images
You can select several images by clicking them in succession or
by holding down the [Shift] key while you click the first and last
images in a series. When you have selected all the images you
want to rotate, select a rotate option to rotate all the selected
images at once.

■ Using the Menu to Rotate Images

You can also rotate an image by selecting it, clicking the [Edit]
menu, selecting [Rotate Image] and choosing the direction of
rotation.

Select an image to rotate and click to specify the direction.
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This section explains how to rename images.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

Renaming an image in ZoomBrowser EX renames the actual file
on your PC.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• Because an extension (indicating the type of the file) is
automatically assigned, do not include an extension in the
name. (In the file named [xxx.JPG], for example, the [.JPG]
portion is called the file name extension.)

Using the Rename Function

Select an image, click the [File] menu and select [Rename].
The Rename Image dialog box appears.

A dialog similar to that below will appear.

Renaming Images

B Click [Rename].

A Click an image to rename.

Type the new name and click [OK] to change the name of the
image. You can also rename a sound that is attached to an
image.

Using the Preview Mode

If you click  (View Mode), choose [Preview Mode] from the
next menu and select an image, you can change the name of
that image.



54      ZoomBrowser EX Software User Guide

Chapter 4
Organizing Images Sorting Images

This section explains the procedures for changing the image order.

Sorting Images

To change the image order in the Browsing Area, click the
[View] menu, select [Arrange] and then one of the sorting
options.

Click [Arrange] and select a menu item.

■ By Name
Sorts images in alphabetical order by the file name.

■ By Type
Sorts images in alphabetical order by the file type.

■ By Date
Sorts images in order from the oldest modification date to the
newest.
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This section explains how to perform searches on images.

Searching Images

You can search for images marked as Favorites or search by
such parameters as the modification date, shooting date or
keywords. The procedures for marking images as Favorites or
adding keywords to them are explained in the following pages.

1. Select a folder to search in the Browsing Area.
Click [Select All] to search all of the images and folders
displayed in the Browsing Area.

2. Click [View & Modify], followed by [Search] in the
next menu.

3. Set the search parameters.

4. Click [Next] after you have set the parameters.

A set of images corresponding to the search parameters will
display.

Sets whether images
are searched
according to all the
parameters or just
one

Clicking here allows
you to hide the
search parameters

Set the search parameters here.
First, place a check mark in the parameter you wish to use.
Next, if you selected the modification or shooting date, set the date range.
If you selected the keyword option, select the keywords.
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5. If the search results are satisfactory, click [Finish].
If you wish to modify the search parameters, click [Previous]
and repeat steps 3–4.

This concludes the search process.
Images satisfying the search parameters will display in the
folder named “Search Results” in the main window.
You can select and print these images, or copy them to other
folders. These images will remain registered in the Search
Results folder until you close ZoomBrowser EX or perform
another search.

Adding Keys for Image Searches

■ Adding the Favorites Symbol to Images
It is easier to find your favorite images if you mark them with a
Favorites symbol. The Favorites symbol is shown below.

There are several methods to mark your favorite images. Use
any one of the following procedures after you have selected
one of your favorite images in the Browsing Area.

• Click the [Tool] menu and select [View/Modify keywords].
Click to place a check mark in the [Favorite Photo] option in
the next window.

• Click  (Properties) and click to place a check mark in the
[Favorite Photo] option in the next window.

• Click  (View Mode) and select [Preview Mode], then select an
image and place a check mark in the [Favorite Photo] option.

• Click the  symbol at the bottom right of the window that
displays while a slide show is playing.

Images satisfying the
search parameters

Folder containing the
images satisfying the
search parameters

Favorites Symbol
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Adding Keywords to Images

Add keywords to images for use in searches.

1. Select the image in the Browsing Area.

2. Click  (Properties) and [View/Modify keywords] in
the next window.
Instead, you can also click the [Tool] menu and select [View/
Modify keywords].
A window for setting keywords will display.

3. Click to place a check mark beside a keyword.

4. Click [OK].
This concludes the keyword settings process.

Place a check mark
beside a keyword

To add a new keyword, type it in the
box at the left and click [+].

Managing Keywords

The following window displays when you click the [Tool] menu
and select [Manage keywords].

You can use the following functions in this window.

■ Add Keywords
Type a new keyword in the box beneath the list and click [+].

■ Delete Keywords
Click to place a check mark beside the keyword to delete and
click [Delete].

■ Restore Keyword List
This function restores the keyword list based on the images
assigned keywords. This can be used when you deleted a
keyword that was used in the past but want it back.
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This section explains how to refresh or update a folder.

What Does It Mean to Refresh a Folder

Adding, moving, copying or editing an image or a folder within
ZoomBrowser EX ensures that it is updated and appears
correctly in the Browsing Area.

However, the information ZoomBrowser EX possesses and the
actual file contents can be different when an image file is
moved or copied using Windows functions or edited with a
separate program.
In this case, the “current state of the folders” has to be
checked and updated. This is what is meant by refreshing a
folder.

Click [Refresh Current Folder].

Refreshing Folders

Click the [View] menu and select [Refresh Current Folder]. This
will update ZoomBrowser EX’s information about all the folders.
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This section explains the procedures for deleting folders.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• When you delete a folder, all the actual images and folders it
contains are deleted too. They cannot be recovered once they
are deleted. Please exercise caution when deleting folders.

Deleting Folders

Select a folder to delete and click  (Delete).

Click [Yes] in the confirmation dialog to proceed.

Alternative Method

■ Using the Menu to Delete
You can also delete a folder by selecting it, clicking the [File]
menu and selecting [Delete].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To completely delete folders from the computer after
completing the procedures above, double-click the [Recycle Bin]
on the Windows desktop to open it and, in the Recycle Bin Task
section, click [Empty the Recycle Bin].
(With Windows 2000/Windows Me/Windows 98 in web page
view mode, click [Empty Recycle Bin] at the left side of the
window.)

Deleting Folders

Select the folder and click [Delete].
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A dialog similar to that below will appear.

Input a new file name and click [OK] to set the name.

This section explains the procedures for renaming folders.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• When you use ZoomBrowser EX to change a folder name, the
name of the folder on the computer disk also changes to that
name.

Renaming Folders

Select a folder to rename, click the [File] menu and select
[Rename].

Renaming Folders

After you select the folder, click [Rename].
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A window similar to that below will appear.
You can check the location of the saved folder by looking at the
categories below.

This section explains methods for finding out which disks and folders
contain your image folders.

Viewing Folder Properties

Select the folder and click  (Properties).

Finding Folder Locations

Select the folder and click [Properties].

Click the  (Close button) to close the window once you have
checked it.

Alternative Method

■ Using the Menu to View Folder Properties
You can also find out where a folder is located by selecting the
folder, clicking the [View] menu and selecting [Properties].
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This procedure is for viewing various information about the selected image.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• When an image taken by the camera is modified and saved by
another program, information about the camera settings might
be lost.

Viewing Image Properties

Select the image in the Browsing Area and click  (Properties)
to open the Properties window.

If you click on another image in the Browsing Area while this
window is open, the displayed data will switch to that of the
new image.
This window can be used to check the date an image was
revised, the file size, the image size, the file type, the file location,
the shooting date and time and other detailed information. You
can also use it to change the file name and type in comments. To
close the Properties window, click its  (Close button).

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• You can select several images by clicking them in succession or
by holding down the [Shift] key while you click the first and last
images in a series. Then you can click  (Properties) to view
the properties of each image in succession. Use the [Previous]
and [Next] buttons to switch between the information for each
image.

• You can also view image properties by selecting the image,
clicking the [View] menu and selecting [Properties].

Shooting Information
(The information in this area will vary
according to your camera model.)

Click this button.
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Alternative Method

You can view the properties of an image by clicking the 
(View Mode) menu, selecting [Preview Mode] in the next menu
and selecting the image.
You can check the file name, comments, histogram and
detailed shooting mode settings in the image properties
window. You can also change the file name and add comments
to the image.

File Name
Comments

You can set settings
for use in searches

Histogram
(graph showing the
distribution of
brightness data)

Shooting Information
(The information in this area will vary
according to your camera model.)
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This chapter explains how to use ZoomBrowser EX’s Camera Window.
It starts with the procedures for opening the window.

Connecting the Camera and Opening the Camera Window

A dialog similar to the following one will appear when you
connect the camera to a computer using an interface cable and
prepare the camera to communicate. If you select [List Images],
the Camera Window will display.

Opening the Camera Window (1/2)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• ZoomBrowser EX may not start with the previous method the
first time a connection is established after the computer is
booted up when some versions of Windows are running. See
the Starting ZoomBrowser EX section of Chapter 1 for details.

Click here.

Camera Window
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Using the Task Buttons to Open the Camera Window

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Ensure that the camera and computer are connected with an
interface cable and are ready to communicate before you
perform this procedure.

• If you are using a memory card reader, ensure that the memory
card is loaded into the reader before performing the procedure.

Click [Camera & Memory Card] in the main window and
[Browse & Download Images] in the next menu.

Main Window
Click here.

A window like that below will open.
Click [List Images] to open the Camera Window.

Click here.

Camera Window
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This section explains the procedures for downloading images from a
camera (memory card) to a computer disk.

Downloading Images

Select the image(s) and click [Download image].

Select the image(s).

Click here.

Specifying the Image File Destination

Specify the location to which your image files are downloaded
on the computer.

Specify the folder to
which images are saved.

Select this option to stick
the downloaded images
in a new folder created
within the one specified
above. Then select a
naming option for the
new folder to the right.

If you selected the [Set as new] option,
type in a folder name here.

If this option is left unselected, the image file names are the same as those
in the camera (file names assigned by the camera at the time of shooting,
such as “IMG_XXXX.JPG,” where the “Xs” represent numbers). If you select
this option and type in a root file name, the name becomes something like
“ROOT+XXXX.JPG.”
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○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The My Pictures folder is set as the default destination.

Click [OK] to start downloading. When the download is
complete, the Camera Window will close and the main window
will open.

The Camera Window after Downloading

Images that have been downloaded are marked with a
“downloaded” symbol like that below.

This symbol indicates that the image has been downloaded.

Alternative Method

■ Downloading Multiple Images
You can select several images by clicking them in succession.
Once the images are selected, you can download them all
together in a single step.

■ Selecting Images for Downloading

Click  (Select) to open the selection menu, which contains
the following options.

• Select All
Selects all the images in the camera (memory card).

• Select New
Selects only the images that have not yet been downloaded
to the computer.

• Select Print mark
Selects only the images that have be marked with print
settings by the camera.
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• Select Send mark
Selects only the images that have been marked with transfer
order settings by the camera.

• Select Slide Show mark
Selects only the images that have been marked with slide
show settings by the camera.

• Invert selection
Deselects selected images and selects the previously
unselected images.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If an image is taken in the Stitch Assist mode, it appears in the
Camera Window as follows:

Mark indicating an
image taken in the
Stitch Assist mode

(You can start
PhotoStitch by
clicking the line with
arrow heads.)

Mark indicating
Movie

Mark indicating
an image taken in
the RAW mode

• If an image is taken in the RAW mode (some camera models do
not come with this feature), it appears in the Camera Window as
follows:

• If an image is taken in the Movie mode, it appears in the Camera
Window as follows:

• If an image has a sound memo attached (some camera models do
not come with this feature),it appears in the Camera Window as
follows:

Mark indicating a
sound memo



69      ZoomBrowser EX Software User Guide

Chapter 5
Using the Camera Window

This section describes how to delete images from the camera (memory
card).

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Please note that deleting an image in the Camera Window
deletes the actual image from the memory card. Since deleted
images cannot be recovered, be extremely careful when using
this function.

How to delete an image in the camera

Select the image you want to delete and click  (Delete) to
delete it.

Deleting Images in the Camera

When a message appears, click [OK]. The image is deleted.

Other ways of deleting images

■ Deleting multiple images
You can select several images by clicking them in succession.
When you have selected all the images to be deleted, perform
the deletion. All the selected images are deleted.

■ Selecting images for deletion

Click  (Select) to display the selection menu, which can be
used to select the images for deletion.

A Select an image.

B Click here.
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This section explains how to rotate the display of images stored in the
camera to the desired orientation.

How to rotate an image

In the Camera Window, select the image you want to rotate.
Click  (Rotate) to display a menu. On the menu, click the
rotation angle that you want to use.

Rotating Images in the Camera

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• 90-degrees left is a counterclockwise rotation and 90-degrees
right is a clockwise rotation.

• The Rotate function affects only the image displayed in the
Camera Window. The image stored on the camera is not
changed at all. However, when you download the image, the
image is rotated and saved on the computer in the correct
orientation.

Other ways of rotating images

■ Rotating multiple images
You can select several images by clicking them in succession.
When all the images are selected, perform the rotation
operation. All the selected images are rotated at once at the
same rotation angle.

A Select an image.

B Click here.
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This section explains the procedures for copying images from the
computer disk to the camera (memory card).

How to copy an image to the camera

Click  (Set) and select [Add Image(s)] from the next menu.

Adding Computer Images to the Camera  (1/2)

A dialog box appears. In the dialog box, select an image you
want to copy to the camera and click [Open].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can upload multiple images in the same operation.

If a dialog similar to that below appears, select an option as
required and click [Add]. This will upload the image to the
camera.

Click here.

Select this to upload the
image to the camera
without resizing.

Select this to resize the image before uploading it to the camera.
Select the image size in the list box beneath. (With a memory
card reader, the image size is input as numerical values. If [VGA
Size] is selected, 640 and 480 appear automatically.)
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○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can select the [Add image as is] option only when
uploading JPEG images based on the DCF standard. Select [Add
image after adjusting size] for all other images.

• JPEG format images can be uploaded to the camera.
• RAW format images and movie files (AVI format) cannot be

uploaded to the camera.
• File formats are explained in more detail in the Supported File

Formats topic in the Appendices.
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This section explains the tasks that can be performed with the task
buttons that weren’t mentioned in the downloading topic.

Task Buttons

Select a task from the four buttons available.

Download Destination Dialog

When you select an image in the Camera Window and click a
task button, a dialog like the one below will appear. Specify the
destination folder to proceed with the next part of the task.

Downloading Images (1/3) in this chapter explains how to
specify a download destination.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• The selected images are downloaded to the computer each time
a task button is selected in the Camera Window and then the
tasks are performed on them.
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Selectable Tasks

The procedures after a download destination has been specified
are the same as below.

■ Download Image
These procedures are explained in Downloading Images in
this chapter.

■ Print
• Layout Print

• Contact Sheet Print
This procedure is described in Printing Images in Chapter 1.

■ View as Slideshow

• These procedures are explained in Running a Slide Show in
Chapter 6.

■ Connect to Internet
• Send Images in E-mail

These procedures are explained in Sending Images by E-mail
in Chapter 6.
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This section explains the additional functions of the Camera Window
that you can use.

Other Functions of the Camera Window

You can play a slide show using the camera or set the
DPOF print settings by selecting [Slide/DPOF] from the
[Set] menu. (These procedures are explained in Setting Up
Slide Shows on the Camera and Print Settings in the
Appendices.)  *

You can reconnect the camera after its connection to the
computer has been interrupted by selecting [Reconnect]
from the [Set] menu.

Click here to deselect images. Click this button to check Image
Properties information.

* Some camera models do not support this button.

On the [Set] menu, select [My Camera] to display the My Camera
window, which can be used to change the start-up image, shutter sound
and other camera settings (these procedures are explained in Saving the
“My Camera Settings” to the Camera section in Chapter 6). *

You can check and change camera settings by clicking the [Set]
button and selecting [Camera Settings]. This procedure is described in
Checking and Changing Camera Settings in Chapter 6.
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This chapter explains how you can use images stored in ZoomBrowser EX
in various situations. First, let’s begin with how you can send images in
e-mail.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• To use this function, your e-mail program must be set up as a
MAPI client. For detailed information on how to set up your e-
mail program, refer to the documentation that comes with it.

How to send an image by e-mail

1. Click [Internet] in the main window.

2. Click [Email Images] in the next menu.

3. In the Browsing Area, select the images you wish to
send and click [Next].
You can select multiple images or a folder and have the images
in the folder included in the e-mail attachment.

The window will change to the image size and image quality
settings window.

Sending Images by E-mail (1/2)

4. Set the image size and image quality settings.

Use this option if you want to
reduce the size of the image.

Use this option if you do not want
to change the size of the image.

Use it to check the file size when you
actually compress the image. (The
file is displayed in the “Total size of
changed images” category.)

Specify the image quality.
(The lower the quality, the rougher
the image becomes, but the size of
the file also becomes smaller.)

Specify the reduction ratio relative to
the original size of the image.

Use it to check the image quality as it will appear
when compressed. (A preview image will display.)
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5. Click [Next].

6. Select whether to create an e-mail message or save
the images.

7. Click [Finish].
• If You Selected [Create a new email]:

Your e-mail program will start and the selected images will
appear as an attachment in the message window. Input the
address, subject and your comments and send the message.

Save the image on
the disk first.

Start the e-mail program and send
the e-mail immediately.

If you selected [Save the images in a
folder to send through an email
program], click [Browse] to specify a
destination.

• If You Selected [Save the images in a folder to send through
an email program]:
The images will be saved to the specified destination. To send
the images by e-mail, start your e-mail program and attach
the saved image files to a message.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also send images by e-mail by clicking the [Internet]
menu and selecting [Send Images by Email].

• Some e-mail programs might not be able to start automatically
(those without MAPI support). In this case, save the image to the
disk, start the e-mail program and attach the image to an e-mail
message.

Sending Images by E-mail (2/2)
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This section explains the procedures for copying images from the
computer’s disks to the camera (memory card).

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Ensure that the camera and computer are connected with an
interface cable and are ready to communicate before you
perform this procedure.

• If you are using a memory card reader, ensure that the memory
card is loaded into the reader before performing the procedure.

Adding Images to the Camera

1. Click [Camera & Memory Card] in the main window.

2. Click [Upload Images] in the next menu.

3. In the Browsing Area, select images and click [Finish].
You can select multiple images or a folder and have the images
in the folder included.

4. Resize the image as required and click [Add].

The Camera Window will open and the specified images will be
added to the camera (memory card).

Select this to upload the
image to the camera
without resizing.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If multiple images have been selected, then the selected resizing
option will affect all the selected images.

Select this to resize the image before uploading it to the camera.
Select the image size in the list box beneath. (With a memory
card reader, the image size is input as numerical values. If [VGA
Size] is selected, 640 and 480 appear automatically.)
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○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can select the [Send image as is] option only when
uploading JPEG images based on the DCF standard. Select [Add
image after adjusting size] for all other images.

• JPEG format images can be uploaded to the camera.
• RAW format images and movie files (AVI format) cannot be

uploaded to the camera.
• File formats are explained in more detail in the Supported File

Formats topic in the Appendices.
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This section explains how to change the size, resolution or file format of
a selected image and write it to a new file, and to export an image for
use as a screen saver or wallpaper. It also describes how to export the
shooting information to a text file.

Export Formats

The following types of image export formats are available.

■ Edit Images and Resave
You can change the file format and/or image size and save it to
a new file. Select one of three file formats: JPEG, TIFF or
Windows Bitmap (BMP). You can also add identifying
characters to the start of the file name.

■ Export Image Shooting Properties
You can select specific items from the shooting information and
export it to a text file.

■ Export Images as a Screen Saver
You can export an image as a screen saver file.

■ Export an Image as Wallpaper
You can export an image as a wallpaper file. This function will
not work with multiple files selected.

■ Copy Images and Rename
You can copy the selected image and save it. At this point, you
can also add identifying characters to the start of the file name.

Exporting Images (1/2)

Exporting Images

1. Click [View & Modify] in the main window.

2. Click [Export Images] in the next menu.

3. In the Browsing Area, select images and click [Next].
You can select multiple images or a folder and have the images
in the folder included.

4. Select an export option and click [Next].
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5. Setting the Export Settings
The contents of the export settings vary according to the
selected export format. Adjust the settings according to the
displayed information. Be sure, however, to note the file name
and destination when exporting so that you do not lose track
of the exported file.

6. Click [Finish].
This will export the image(s).

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If you use the [Edit Images and Resave] or [Copy Images and
Rename] options and save in the JPEG file format, the shooting
information is saved along with the image.

Destination folder
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This section explains how to run a slide show displaying images in
sequence in the full-screen mode.

Setting and Starting a Slide Show

1. Click [View & Modify] in the main window.

2. Click [View as a Slide Show] in the next menu.

3. In the Browsing Area, select images and click [Next].
You can select multiple images or a folder and have the images
in the folder included.
The images will display in the order they are selected here.

Running a Slide Show (1/2)

Specify whether to stop the slide
show (upper button) or continue
running it (lower button) when
it comes to the end.

Select the Image Size option to
be used when displaying the
images.

Selects the display methods for
image information, such as the
file name and titles, and the
control panel (explained on
the next page).

Select the transition effect to be used
when moving from one slide to another
(When you click an effect, you can get a
preview of how the effect looks)
If you want the transition effects to be
randomly assigned, select [?].

Select [On clicking the left mouse button] to have the slides
proceed manually, not automatically.
Select [Every X seconds] to have the slides advance
automatically and set an interval in seconds with the slider.

4. Set the display settings for the slide show and click
[Finish].
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The slide show starts.

Click this button to return
to the previous image.

Click this button to move
to the next image.

Click here to pause the show
(Click again to resume play)

Click here to end
the slide show

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also start a slide show by clicking the [View] menu and
selecting [View as a Slide Show].

While running a slide show, you can use the control buttons at
the bottom right of the window to control the show.

The file name and control panel will display if the
[Show information] option was selected in the
[Image Information] section shown in the settings
on the previous page.

Click this button if you see an image you would like to
print during a slide show. (The color of the button will
change to orange.)
When the slide show finishes, PhotoRecord (printing
utility) will automatically start and the selected image will
appear in the printing window.

If you click this button while an image is displayed, the image will
appear in the selected state in the Browsing Area after the slide show.

Click here to add the Favorites symbol to images. It is
used to facilitate image searches.
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You can add sounds to your images and play them later as necessary.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To use a sound file with images, it must be of one of the follow-
ing formats:
WAVE (with WAV extension)
MIDI (with MID or MIDI extension)

How to add a sound to an image

In the Browsing Area, select an image, click the [Edit] menu and
select [Add/Remove Sound].
The following dialog box appears.

Adding Sounds to Images

Click [Add]. In the file dialog box, select a sound file and click
[Open]. Next, click [OK] to add the sound to the image that you
selected.

The following mark appears when an image is accompanied by
a sound.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To remove a sound from an image, select the image, click the
[Edit] menu and select [Add/Remove Sound], then click [Remove].

• When you add a sound to an image, the sound file is copied to
the same folder as the image.

How to play a sound added to an image

Select an image with a sound attachment, click the [Edit] menu
and select [Play Sound].

This mark indicates an
image with a sound.
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You can check camera settings from the computer.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Ensure that the camera and computer are connected with an
interface cable and are ready to communicate before you
perform this procedure.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also adjust the camera settings by clicking  (Set) in
the Camera Window and selecting [Camera Settings] in the next
menu.

Checking and Changing Camera Settings

Click the [Camera] menu in the main window and
select [Camera Settings].

Checking and Changing Camera Settings

Type the name of the owner of the camera here.

Click this button to
synchronize the camera’s
date and time settings
with the computer.

Use this button to synchronize the
camera clock and your PC clock.

Click this button to
format the camera’s
memory card (not
supported by some
camera models).

This will display a window like the following. You can check or
change each setting in this window.

After you have checked the camera settings and made
necessary changes, click [OK].
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This section explains how to save the “My Camera Settings” on your
computer to the camera or vice versa.

What are the My Camera Settings?
The start-up image for the camera and sounds such as the
start-up sound, the shutter sound, operating sounds and the
self-timer sound are collectively referred to as the My Camera
Settings. You can add your favorite images and sounds from
your computer to the My Camera Settings in the camera.

Displaying the My Camera Settings
ZoomBrowser EX comes with some My Camera Settings already
prepared. Start by displaying this data.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Ensure that the camera and computer are connected with an
interface cable and are ready to communicate before you
perform this procedure.

Click the [Camera] menu in the main window and
select [My Camera Settings].

Saving the “My Camera Settings” to the Camera (1/7)

The My Camera window displays.

Changes the type
of data.

My Camera Settings that are
already on your computer display
here.

My Camera Settings
in your camera
display here.

Switches between theme
sets and individual settings.

Try switching between the [Setup as a theme] and [Set Individually]
tabs, and in the [Set Individually] tab, try changing options in the
Data Type category. The My Computer list displays the image files
and sounds that were previously prepared. The Camera list displays
the My Camera Settings currently in the camera (only the editable
settings are shown).
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You can save the files that appear in this list as My Camera
Settings to your camera.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Theme settings are a collection of My Camera Settings with
something in common.

• You can change all of the My Camera Settings—the start-up
sound, the start-up image, the shutter sound, the operating
sounds, and the self-timer sound—on the camera in one easy
step by selecting the [Setup as a theme] tab and saving the
desired theme set to the camera.

• You can also add new files as My Camera Settings to the
Computer list (the procedure is explained later in this section).

• Pre-prepared My Camera Settings can be found on the disk on
which ZoomBrowser EX was installed. Open the following
sequence of folders: [Program Files], [Canon], [ZoomBrowser EX],
[CameraWindow] and [MyCameraFiles].

• You can also open the My Camera window by clicking the [Edit]
menu and selecting [My Camera Settings].

Select the [Setup as a theme] tab.

Saving the My Camera settings to the camera

This topic explains how to save the previously recorded My
Camera Settings files to the camera.

1. Select the [Setup as a theme] tab in the My Camera window.
To set the My Camera Settings individually, click the [Set
Individually] tab instead and select the respective settings, such
as the start-up sound or image, in the Data Type category.
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Repeat Steps 1-3 to replace all the settings files with those you
wish to save to the camera.

Saving the “My Camera Settings” to the Camera (3/7)

3. Select the settings file you would like to replace in the
Camera list and click [Save to Camera].
The settings file in the Camera list will be replaced by the
settings file from the My Computer list. If the settings file has
the same name, it will be overwritten.

A Select the setting you want to replace.

B Click this.

2. In the My Computer list, select a setting you would
like to add to the camera.
When you select [Setup as a theme]:
A start-up image will be displayed in the preview area to the
right and the start-up sound, shutter sound, operation sound
and self-timer sound will be played in succession.

When you select [Set individually]:
When you select a start-up image, it will be displayed in the
preview area to the right. When you select a sound file, it will
automatically be played.
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Adding New Files to the My Camera Settings

Create a new image or sound file and save it to the computer
and then add that file as a My Camera Settings file.

Saving the “My Camera Settings” to the Camera (4/7)

4. Click the [Close] button to close the dialog.
This concludes the procedure for adding settings to the camera.

Next, you will have to change the settings on the camera itself to
use the new start-up image and sounds. See the guide supplied
with your camera for instructions for changing the settings.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Never detach the interface cable, turn off the camera power, or
do anything to stop communication between the camera and
computer while the My Camera Settings are being saved to the
camera.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To delete settings files in the Camera list, select the file and click
the [Delete] button.

• You can check a sound file in the camera by clicking [Play].

Click here to delete a file from the list.

Click here to check a sound file in the
camera.

Displays the camera settings when
an image file is selected.
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■ Adding the new file as My Camera Settings to the
computer

Once you have created the settings file and saved it to the
computer, use the following procedures to add it to the My
Camera window.

1. Click the [Set Individually] tab in the My Camera window
and switch the Data Type.

Click [Add File].

2. Click [Add File].

Create the new files before adding them

Start by creating the image file or sound file that will be used as
a My Camera Settings file and save it to the computer.

■ Creating a Start-Up Image File
Create an image file using an image editing program.
The file should be in the JPEG format, 320 x 240 pixels, and less
than 20KB.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See the manual and help facility for the editing program for a
detailed explanation of how to use it.

■ Creating a Sound File
Use the functions of the My Camera Sound Maker to record
and edit sounds. The My Camera Sound Maker functions are
explained on the next page.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Record the sound as an 11.025 kHz or 8.000 kHz, 8 Bit, Mono
sound in the WAV format. Sound files that can be added to the
camera should conform to these guidelines.

Type 

Start-Up Sound

Operating Sound

Self-Timer Sound

Shutter Sound

11.025 kHz

1.0 sec. or less

0.3 sec. or less

2.0 sec. or less

0.3 sec. or less

Duration in Seconds

8.000 kHz

1.3 sec. or less

0.4 sec. or less

2.0 sec. or less

0.4 sec. or less

Click the [Set Individually] tab in the My
Camera window and switch the Data Type.
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3. In the Open dialog, select the file you created and
click [Open].
The selected file will appear in the Computer list.

This concludes the process for adding the new settings.
You can save the newly created settings to the camera using
the procedures described in the Saving the My Camera Settings
to the Camera section.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To delete a settings file, select it and click the [Delete] button
beneath the My Computer list.

• Previously created settings can also be added as My Camera
Settings to the computer with the same procedures as above,
but have to comply with the specifications listed in the Create
the new files before adding them section.
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Saving the Settings to the Computer

You can copy the My Camera Settings from the camera to the
computer.

1. Click the [Setup as a theme] tab in the My Camera
window.
To set the My Camera Settings individually, click the [Set
Individually] tab instead and select the respective settings, such
as the start-up sound or image, in the Data Type category.

2. Select the setting you would like to copy from the
Camera list.
If you selected the Theme tab in Step 1, the preview image will
display in the area to the right and the start-up sound, the
shutter sound, the operation sound and the self-timer sound
will play in order.
If you selected the Set Individually tab and the start-up image in
the Data Type category in Step 1, the start-up image will display
in the area to the right. If you selected a sound, it will
automatically play.

3. Click [Save to PC].

4. Assign a name to the settings file and click [OK].
The settings file will copy to the computer disk. If there is a
settings file with the same name, it will be over-written.

Repeat steps 1-4 as required to save the settings files you wish
to copy to the computer.

5. Click [Close] to close the My Camera window.
This completes the copying process.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Never detach the interface cable, turn off the camera power, or
do anything to stop communication between the camera and
computer while the settings files are being copied.
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Creating a My Camera Sound

The following section introduces the [My Camera Sound Maker]
function, which allows you to record and edit the start-up
sound, shutter sound, operation sound and self-timer sound.

Click the [Camera] menu in the main window and
select [Create a My Camera Sound].

The My Camera Sound Maker window will open.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• The My Camera Sound Maker window will not appear if
QuickTime is not installed.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• For detailed information on how to use this function, please
refer to the Help file (open it with the [?] button).

Click here to record sounds.

Click here to open sound files.

Change the file format.

Ends the recording.

Displays the Help menu.

Cuts out unnecessary sound portions.

Use these tabs to switch between sound files for recording and editing.

Volume

Sets the blue and
red switches.

Plays sounds.

The blue and red switches designate the sound
range. (You can delete useless sections by
clicking the [Cut] button after having selected
the desired sound portion with the switches)

Shows from where the
sound starts to play.

Recording and Editing Sounds
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○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• The “Sound time” will display in red if the sound file exceeds
the time limit.
If this happens, select the desired sound portion using the blue
and red switches and select [Cuts both switches, before blue
and after red] from the [cut] menu to delete unnecessary sound
portions.
In addition, when you select [Limits blue and red switch within
limit time], the switches can no longer be moved outside of the
time limit width.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The Volume switch setting affects the volume of the sound file
to be saved. In other words, if you turn down the volume of a
sound you recorded on the computer because it is too loud
when you play it, the sound will have a low volume when you
upload it to the camera. So when the playback volume is too
loud on the computer, turn down the volume of the speakers.

Saving a Sound

Click here to save a sound (A window allowing you to name the file will display).

Select the sound to be saved.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Each sound file is automatically given an extension according to
the type of sound.

• The actual file name is composed of the name of your choice in
the first part, followed by characters specifying the sound type
(_OP01 or _SS01) and the extension (.WAV) in the latter part.

• When a number of different types of sounds are saved at the
same time, the first part of their file name will be the same.
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ZoomBrowser EX supports movies.

When you connect a camera with movie files on it to the
computer and open the Camera Window, a thumbnail of the
first image of each movie file will display with a movie camera
symbol on it.
You can import movie files in the Browsing Area the same way
you do images. In this case, a thumbnail and a movie mark
appear in the Browsing Area. When you double-click the
thumbnail, QuickTime Player starts and plays the movie.

Playing Movies

QuickTime Player window

Use this button to
play the movie.

The thumbnail and mark appear
when a movie is imported using
the Camera Window.
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You can create movies by adding various effects: linking movies and still
images that have been downloaded to a computer, superimposing titles
and other text, and adding background music.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Movies are saved as AVI files in the Motion JPEG format.

Procedures for Editing Movies

1. Click [View & Modify] in the main window, followed
by [Edit Movie].

2. Select a file (movie or still image) to edit in the
Browser Area and click [Next].
You can select multiple movies or still images.

3. Follow the steps at the window’s left. Once you have
finished editing the movie, save it and close the
window.
The features and procedures for each step are explained on the
following pages.

Follow these steps
to proceed

Guidance Click this button for detailed help
with operating procedures

Storyboard Area
Displays thumbnails of the selected images.
Links images in order from left to right

Click here to proceed to the
next step or previous one
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Features of the Storyboard Area

Editing Movies (2/4)

Transition Box
Displays the icon of the transition
effect used to link adjacent images

Displays a dialog with the general
movie editing settings

Changes the order of the
selected images

Displays the properties of the
selected image

Deletes the selected image from
the storyboard area

Click this button to play
the movie being edited
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Features of the Arrange Window Features of the Apply Effect Window

Editing Movies (3/4)

Moves the image selected in the storyboard area one
position to the left or right

You can set the playback range (start and stop points) of a
movie selected in the storyboard area by clicking this button

You can set the play duration of a still image selected in the
storyboard area by clicking this button

Superimposes titles and other text on the image
selected in the storyboard area

You can set the font, display duration, display
position and scrolling attributes of the text

You can set the transition effect between
images by selecting the transition effect box in
the storyboard area and clicking this button

You can change the image selected in
the storyboard area into a sepia or
monochrome image, or add noise for a
film simulation
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Features of the Set Audio Window Features of the Save Window

Editing Movies (4/4)

You can link MP3-format and WAV-format audio files as
background music or sound effects
When you link a sound file using this procedure, a bar appears
under the thumbnail in the storyboard area indicating the
duration of the audio file

You can adjust the volume or set the fade-in or fade-out
effect for a movie or its linked audio file by selecting it in the
storyboard area and clicking this button

Specifies the file name

Selects the destination folder

Saves the file
You can set the size (height and width in pixels) and
frame rate (frames/second) of the movie being
saved by selecting [Motion JPEG (AVI)] and clicking
the [Advanced Settings] button at the right
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This feature changes a movie to another file format or size and exports it.

Procedures for Exporting Movies

1. Click [View & Modify] in the main window, followed
by [Export Movies].

2. Select a movie in the Browser Area and click [Next].
You can select multiple movies.

3. Follow the steps at the window’s left-hand side to
proceed. Finish by exporting (saving) the movie.
The features and procedures for each step are explained on the
following pages.

Follow these steps
to proceed

Features of the Select the Save Format Window

Select between [Motion JPEG (AVI)] and [QuickTime movie (mov)] as
the format in which to save the movie file

To save the movie in a rotated orientation, click here to add a check
mark and specify a rotation direction.
Use this feature when a camera has been turned on its end to shoot
a movie sequence
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Features of the Set the Save Format Window Features of the Specify Name of File to be Saved Window

To save the movie under its original file name, select [Same as
original image]
To assign sequential numbers in a multiple movie selection, select
[Assign Sequence No.] and specify a root name to precede the
numbers

Selects the destination folder

To change the size of the movie being exported, select [Zoom
specification] or [Size specification] and set the size

Selects the number of frames
displayed each second

Sets the image quality. The
higher the setting, the clearer the
image, but the file size also
increases correspondingly
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If your camera supports RAW images you can handle higher quality
images.
However, the RAW format is a special file format and RAW images
cannot be opened or processed in their native format in standard image
processing programs. RAW images must first be converted to standard
file formats, such as TIFF or JPEG formats. This section explains
conversion procedures.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Refer to the manual supplied with your camera to determine
whether your camera supports RAW images or not.

• Depending upon your camera model, a different program than
the one introduced here may start when you convert RAW
images. If that occurs, refer to the manual for the software
supplied with your camera.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• RAW images are extremely high-quality images that are not
subject to any deterioration due to compression processing.

• See the Help menu for conversion details. After you click
[Process RAW Images], click the [Help] menu in the main
window.

Converting RAW Images

1. Select a RAW image in the Browser Area.

2. Click [View & Modify] in the main window, followed
by [Process RAW Images] in the next menu.

As shown on the next page, the main window, Navigator
window, and Image Quality Adjustment Window will display.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If the Navigator window and Image Quality Adjustment Window
do not appear, click the [View] menu and select [Show
Navigator] or [Show Image Quality Adjustment Window].
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■ Main Window
The conversion is conducted in this window.

■ Navigator Window

■ Image Quality Adjustment Window
You can adjust the brightness, contrast and coloration of a
RAW image as it is converted. See the Features of the Image
Quality Adjustment Window in the following pages for details.

Thumbnail

Check Mark

Preview

You can use this
button to switch
between images
and display modes
and set various
conversion settings,
such as the image
rotation

You can change the area of a
preview image that is
zoomed in the main window
by clicking this red frame
and dragging it

Converting RAW Images (2/5)
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3. Adjust the image quality as required in the Image
Quality Adjustment Window.

4. Click the [2. Save] tab in the main window, set the file
format and save destination, and then click [Save].

5. Click the [3. Exit] tab and click [OK].

Selects images that will be saved
with the same settings (All
images, or images marked with a
check in the main window)

Selects the image file format

Sets the destination folder
for the image file

You can change the image
file name

Converting RAW Images (3/5)



105      ZoomBrowser EX Software User Guide

Chapter 6
Using Supplementary Features Converting RAW Images (4/5)

Features of the Image Quality Adjustment Window

Adjusts the white balance
by the light source or
color temperature, etc.

Adjusts the exposure
compensation, photo
effect, contrast,
saturation, and sharpness

With a check mark here,
settings changes in this
window are immediately
reflected in the image

Selects preset color schemes or
My Color custom color schemes
(see next page for explanation)

Applies the settings to the
displayed image

Restores all adjustments to the initial shooting settings

Scrolling Tab Titles
Click the arrows to display the other tab titles. Click a
tab title to change tabs and access the other settings

Tone Curve Tab
You can adjust the RGB
channel settings
together or individually

Advanced Adjustments Tab
You can set the settings for
noise reduction processing,
fading correction and the
output color space
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Registering Custom Color Schemes (My Color)

If you register a custom color scheme as a “My Color” scheme,
you can apply this scheme easily to additional images when you
convert RAW images.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• To register a “My Color” scheme, two images are required: the
pre-adjustment image and the post-adjustment image. Use
ZoomBrowser EX’s image editing functions to prepare the two
images before proceeding. Save the two images in the BMP, TIFF
or JPEG format.

1. Click the [Edit] menu and select [My Color].

2. Select [Create and Add My Color] from the next
menu, followed by [Next].

3. Click [Read] beside the
original image, select the pre-
adjustment image (original
image) and click [Next].

4. Click [Read] beside the target image, select the post-
adjustment image (target image) that you have modi-
fied with an image editing program, and click [Cre-
ate].
The program will calculate the differences between the original
and target images, apply those corrections to the original image
and display the results as the Preview My Color Applied to the
Image.

5. Check the Preview My Color Applied to the Image and
click [Next].

6. Type a name or comment and click [Finish].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can apply the registered My Color scheme to additional
RAW images when you convert them by selecting it from the
Photo Effect menu in the Image Quality Adjustment Window.
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This section explains the procedures for remote shooting, the process of
operating the camera shutter remotely from a connected computer.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• To confirm whether your camera supports remote shooting or
not, check the guides that accompanied the camera.

• Ensure that the camera and computer are connected with an
interface cable and that the camera is ready to transfer data
before attempting remote shooting. If the camera is equipped
with a lens cover, ensure that it is open.

• Ensure that you turn off your computer’s standby feature before
you begin remote shooting. The results cannot be guaranteed if
the computer enters the standby mode while remote shooting.

• Except for the shutter button, the camera’s buttons and
switches, including the zoom, cannot be manually operated
while the camera is being remotely controlled.

• The time lag between pushing the shutter button and the
release of the shutter is slightly longer for remote shooting
compared with the normal mode of operation.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See the Help menu (it can be opened from the [Help] menu in
the remote shooting window) for detailed operating procedures
for remote shooting.

• Images captured while remote shooting are saved into the folder
that was selected when [Remote Shooting] was clicked.

Operating the Camera Shutter from the Computer (1/4)

Remote Shooting Procedures

Check to make sure that the camera is attached to the
computer and ready to transfer data, then click [Camera &
Memory Card] in the main window, followed by [Remote
Shooting] in the next menu.

A remote shooting window like that below will open.
Clicking the [Release] button in this window records the image.

The image captured by the
camera displays here

This button turns the
display on or off
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Features of the RemoteCapture Task Window

Releases the camera shutter
(you can also release it by pressing the camera’s shutter button
or the space bar on the keyboard)

Selects the image’s recording size and compression
Sets the rotation setting of the image being recorded.
This setting cannot be adjusted if your camera’s Auto Rotate
function is set to On.

Viewfinder

Sets the camera’s zoom

Turns the viewfinder display on or off

Refreshes the exposure, focus and white balance settings
(these settings remain fixed until this button is clicked)

Sets the shooting settings. It is divided into the “Field angle/
flash” tab and the “Shooting settings” tab.
(The settings categories vary according to your camera model)

Switches between showing and hiding
the viewfinder and the detailed
settings sections.

You can add a comment to an image
by clicking to place a check mark
here and inputting text in the box
below.
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Other Remote Shooting Features

■ Interval Timer Shooting
Interval timer shooting is the method of capturing images in
which a set number of frames is recorded at set intervals of time.

Click the [Shooting] menu in the
RemoteCapture Task window and select
[Interval Timer Shooting] to open a
confirmation dialog. Click [OK] to open
a window like the one shown here. Set
the values and click [Start] to start
shooting. The interval may be set to a
range from 5 seconds to 60 minutes.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You may not be able to record at the set interval if it is too short
for the camera to transfer and save the image data.

■ Timer Shooting

Timer shooting is the method by which a single image is
recorded after a set number of seconds.

Click the [Shooting] menu in the
RemoteCapture Task window and select
[Timer Shooting] to open a window like
the one shown here. Set the number of
seconds for the delay and click [Start]. The
timer may be set to a range from 2
seconds to 30 seconds.

■ Saving and Recalling Shooting Settings
You can save the current zoom settings and the settings in the
“Field angle/flash” and “Shooting settings” tabs by clicking the
[File] menu in the RemoteCapture Task window and selecting
[Save Shooting Settings].

Later when you wish to recall those settings, click the [File]
menu in the RemoteCapture Task window and select [Batch
Shooting Settings].

■ Displaying the Subject in the Camera’s LCD Monitor

You can use the camera’s LCD monitor or a television
connected to the camera to view the subject while shooting
remotely.

Click the [Camera] menu in the
RemoteCapture Task window and select
[Camera Display Settings] to open a window
like the one shown here.

Select [Camera LCD monitor] or [Video Out
terminal] and click [OK].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See the Camera User Guide for instructions for connecting the
camera to the television.
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Remote Shooting Default Settings

You can display the default settings for remote shooting by
clicking the [File] menu in the RemoteCapture Task window and
selecting [Preferences].

■ File Settings Tab

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If you click [Save Images On] and select [Computer only], you
can record images when the memory card in the camera is full
and will not accept more images or when it is not present.

■ Options Tab

Sets whether images are saved only to
the computer, or also to the camera’s
memory card

Folder to which recorded images are saved
(folder selected at the point when remote shooting was started)

Sets the root file name for saved images.
For example, if you type “Capture,” file
names are automatically assigned in
ascending order starting from
“Capture_00001.jpg”.
You can also change the number of
assigned digits and the starting number

You can release the shutter using the
key specified here

Click to place a check mark here to
have the RemoteCapture Task
window remain in front at all times
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If you have several images of the same scene with only slight differences,
you can use PhotoStitch to connect the images together to make a
panoramic image. This section explains how to use this program to stitch
images.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• For detailed information on how to use PhotoStitch, refer to
PhotoStitch Help (accessible from the [Help] menu).

• You can make it easier to stitch images together by using the
camera’s Stitch Assist mode to shoot them.

Opening PhotoStitch

Click [View & modify] in the main window, followed by [Stitch
Photos] in the next menu.

Stitching Panoramic Images - PhotoStitch

In the Browsing Area, select the images you would like to
merge and click [Finish].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also start PhotoStitch by clicking an image with the
Stitch Assist mode mark (a line with arrows) in the Camera
Window.

Perform stitching.

Decide the order
in which the
images should be
stitched.

Save the image.

Then, follow the instructions on the upper part of the
PhotoStitch window, and stitch your images together.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also start PhotoStitch by clicking the [Tools] menu and
selecting [Stitch Photos].
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Saving Images to CD-R/RW Disks

You can copy or save images onto CD-R disks and CD-RW
disks. The shooting information is saved along with the image.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• This feature is only possible with computers satisfying the fol-
lowing conditions.
- Windows XP is pre-installed
- A CD-R/RW drive is built-in

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can add additional images to a CD-R/RW disk that has been
written to previously.

1. Place a CD-R/RW disk in the drive.

2. If a window like the one shown here appears, click
[Cancel] and close the window.

3. Click [View & Modify] in the ZoomBrowser EX main
window and [Backup to CD] in the next menu.

4. In the Browsing Area, select the images or folders you
wish to save and click [Next].

5. Select the destination CD-R/RW drive, input a title for
the CD and click [Finish].

Destination drive

CD Title

Available space on the CD-R/RW disk

This will copy the images to the CD-R/RW disk.
The disk will be ejected from the drive when copying is complete.

Speed
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The following is a list of file formats supported by ZoomBrowser EX.

Readable files

ZoomBrowser EX can read the following file formats.

■ JPEG files (.JPG)
Most cameras use this file format. It compresses at very high
ratios, taking advantage of the characteristics of the human
eye. However, because it is an irreversible compression method
(part of the data is lost during compression), if you process and
save an image repeatedly using this method, the image may
become rougher.

■ RAW files (.CRW)
This format is a proprietary file format provided by Canon. It
saves the output of the image pixels from a digital camera
without any deterioration in the quality of the image. Some
cameras might not support this file format.

■ Windows bitmap files (.BMP)
This format comes standard with Windows. Most Windows
programs support it.

■ TIFF files (.TIF)
This is a relatively popular format. It is widely supported by non-
Windows programs (such as Macintosh).

■ PhotoCD files (.PCD)
This is the format used by Photo CDs.

■ Video clip files (.AVI)
This is the standard Windows video file format. The
ZoomBrowser EX Browsing Area will display a thumbnail image
and the video camera symbol.
When you click the thumbnail or movie icon, QuickTime Player
starts and plays the video clip. (You must install QuickTime
Player before you can use it.)

■ QuickTime files (.MOV)
This is a movie file format. The file appears as a movie mark in
the Browsing Area of ZoomBrowser EX. When you click the
movie mark, QuickTime Player starts and plays the movie. (You
must install QuickTime Player before you can use it.)

Supported File Formats
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You can set which downloading method is used after ZoomBrowser EX
starts automatically when the camera is connected to the computer.
You can also use this setting to specify the downloading process when
the camera is connected to the computer after ZoomBrowser EX is
already running, or when you click the [Camera & Memory Card] task
button and select [Browse & Download Images].

1. Click the [Camera] menu and select [Auto-download
setting].

The Auto-Download Settings window will open.

2. Select the action executed when the camera is con-
nected and click [Next] or [Finish].

If you select this option, the Camera Window will
automatically open when the camera is connected.
After choosing this option, click the [Finish] button
to close the settings window.

If you select this option, the images in the camera will automatically download
to the computer when the camera is connected.
However, if you place a check mark beside the
[Display confirm message before downloading]
option, the window at the right will display,
allowing you to select an action.
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3. Select the type of images to download and click
[Next].

4. Select the image destination and click [Next].

If you click either of these two options, only the images
selected with the camera functions will download.

Specifies the folder to
which images are saved

Select this option to have the images saved
into new folders created within the folder
specified in the category above. Select from
the options below for the naming
conventions for the new folders.

Type a folder name here if you
select the [Set as new] option.

If there is no check mark in this option, the file name for the image is kept the
same as the file name in the camera (the file name assigned by the camera
when the image is recorded). For example, the name might be
“IMG_XXXX.JPG.” If you place a check mark in this option and type a root
name, the image file name becomes “root + XXXX.JPG,” where root is the
word you type and the “Xs” represent numbers.
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5. Choose the action to be executed after images are
downloaded and click [Finish].

After downloading, you can have it continue to process images.
- Layout Print
- Contact Sheet Print
- View as slideshow
- Send by e-mail

After downloading, display the
folder containing the images
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ZoomBrowser EX provides a variety of preference settings that you can
customize to make the program work the way you like. This section
introduces some of the major preference settings you can change.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• ZoomBrowser EX offers a wide variety of preference settings that
you can customize. Therefore, before you modify an option,
access Help from the [Help] menu or the [?] (Help) button to see
a description of the option.

Opening the Preferences dialog box

Click the [Tools] menu and select [Preferences] to open the
Preferences dialog. To change a setting, click the appropriate
tab in this window.

Customizing Preferences (1/3)

General Tab

Sets the thumbnail settings for the Browsing Area and the
zoom options.

Sets the thumbnail
settings for the Browsing
Area.

This group box controls
the way the zoom
operations react in the
Browsing Area (Moving
the slider to the right
increases the image
display speed).
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Image Editor tab

This tab selects the application program when a program other
than ZoomBrowser EX is used to edit images.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• “Edit images using the default editor below” has a list contain-
ing an image editing program that is detected automatically. If
you want to use a specific program other than the default, click
“Edit images using the program below” and use the [Browse]
button to locate the program.

Selection Tab

This tab sets the image selection methods and the image
selection steps used with the task buttons.

Selects the program to
start when you click the
[View & Modify] menu in
the main window and
select [Edit Image].

Sets the image selection
method.

Customizing Preferences (2/3)

Remove this check mark to streamline the image
selection steps when a task button is used.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• With [Windows standard selection], the first image is deselected
when a second image is clicked. Multiple selections can be
made by holding down the [Ctrl] and [Shift] keys while clicking
on successive images.
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Rotate Tab

This tab sets the rotation settings.

Place a check mark here
to have the original
image rotated as well
when a JPEG image is
rotated in the Browsing
Area.
Only the rotated image
is sent to the Browsing
Area when you
download an image that
has been rotated in the
Camera Window.

Place a check here to have the original image left
untouched and the rotation applied to a copy
when a JPEG image is rotated.
Both the original image and the rotated image
are sent when an image rotated in the Camera
Window is downloaded to the Browsing Area.



120      ZoomBrowser EX Software User Guide

Appendices Customizing Menus

Sets whether options are shown or hidden on the menus opened by
clicking task buttons in the main window.

Click the [Tool] menu and select [Customize] to open a window
like the one shown below.
Use this window to set the categories to display and click [OK].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Use this function to hide items not used on a daily basis to
streamline the menus or to shorten the menus so that scrolling
is not required.

Sets the categories displayed in this menu.

Remove the check mark from the menu items you wish to hide.
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If the camera comes with a slide show feature, you can use
ZoomBrowser EX to edit slide shows.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Ensure that the camera and computer are connected with an
interface cable and that the camera is ready to transfer data
before you perform this procedure.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See the guide for your camera for information on using and
playing slide shows.

• You can also set slide show settings by clicking  (Set) in the
Camera Window and selecting [Slide/DPOF] in the next menu.

How to set up a slide show

Click the [Camera] menu in the main window and select [Edit
Slide/DPOF]. Click the [Slide Show] button at the top left of the
next window and select the number of the slide show you wish
to edit.

Setting up Slide Shows on the Camera

From the image list on the left, drag images to the right area
and arrange their sequence for the slide show.

When you are done arranging the slide sequence, click [Save to
Camera] to save the slide show setup.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If you want to change the sequence of some images, just drag
them to the right place in the area on the right.

• If you want to remove an image from the slide show, select the
image. On the [Edit] menu, click [Clear].

From the image list on the left, drag images to
the right area and then arrange their sequence
for the slide show.

Select a slide show number.
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You can use ZoomBrowser EX to register print settings on a memory
card, including the images to print and the number of copies.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• This feature does not work with unconverted RAW images. If
you want to print RAW images, convert them first, copy them to
the camera and perform this operation.

• Ensure that the camera and computer are connected with an
interface cable and that the camera is ready to transfer data
before you perform this procedure.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• DPOF is a standardized format for recording print settings, such
as the image selection and number of copies. After DPOF print
settings have been set, you can take a CF card or PC card to a
camera store or developing laboratory and have the images
printed according to the settings.

• You can also set the print settings by clicking  (Set) in the
Camera Window and selecting [Slide/DPOF] in the next menu.

How to make DPOF print settings

Click the [Camera] menu in the main window and select [Edit
Slide/DPOF]. Click the [Print Order (DPOF)] button at the top left
of the next window and select the print type.

Print Settings (1/2)

■ Standard Print
Prints the specified number of copies of the images that you
selected.

■ Index Print
Prints only thumbnails of the images that you selected.

■ Both (Standard/Index)
Prints the specified number of copies and thumbnails of the
images that you selected. In addition, it produces an index print
of small versions of all the images.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

You can also click [Edit] and then click [Include in index print] to
include the image date and file number in the prints.

Select the print type.
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Standard printing

The number under each image indicates the number of copies
to print. Use the arrows next to the boxes to select the number
of copies you want.

Specify number of
copies to print.

Select the check box to include
the image in the index print.

When you are done with your selections, click [Save to Camera]
to save the information.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The procedure explained above also applies when the print type
is “Both (Standard/Index)”.

Index printing

To include images in an index print, select the check box under
the image.

When you are done with your selections, click [Save to Camera]
to save the information.

The standard print icon displays when
a number of copies is specified.

The index print icon displays when a
check mark is added to the image.
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This section explains how to troubleshoot problems.

The event dialog box does not appear

The dialog below fails to appear even though the camera is
correctly connected to the computer via the interface cable and
ready to transfer data…

Troubleshooting (1/4)

Or, a message, such as “No camera was found”, appears when
you attempt to download images from the camera…

In either case, confirm the status of each of the following items
in order.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• With some versions of Windows, this dialog may not appear the
very first time the camera is connected to the computer after it
is booted up. (It will display subsequently.)
In that case, use either of the following procedures.

• Start ZoomBrowser EX
Double-click the [ZoomBrowser EX] icon on the desktop.

• Connect the Camera
Click the [Start] menu and select [Programs] or [All Programs],
followed by [Canon Utilities], [CameraWindow] and
[CameraWindow].

■ Check your Computer
Ensure that your computer meets the following requirements.
ZoomBrowser EX will not operate on computers failing to meet
these requirements.
• Built-in USB ports on a computer pre-installed with Windows XP,

Windows 2000, Windows Me, or Windows 98 (First or Second
Edition).

■ Check the Connection between the Camera and Computer

Confirm that the camera is correctly attached to the computer
with an interface cable. For information on the connection,
refer to the documentation that comes with the camera.
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■ Check the Camera Status
Confirm that the camera is on and in the correct mode to
transfer data. Because the procedures for preparing the camera
for communication differ among camera models, refer to the
documentation that accompanied your camera for more
information.

■ Check the battery

You are recommended to use a household power source (AC
adapter) for the camera when connecting it to the computer. If
the camera is running on batteries, ensure they are fully
charged.

If the problem does not rest in the four areas above, the driver
may not be properly installed. Uninstall the driver and then
reinstall it. For instructions for this task, refer to the Software
Starter Guide.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The Events dialog will not display when a memory card reader is
used.

If You Were Using ZoomBrowser EX Version 2 or 3

■ Images Were Assigned Titles or Comments
Use the following procedures to display titles and comments
previously input in ZoomBrowser EX Ver. 2/3.

1. Start Windows Explorer by clicking the [Start] menu
and selecting [All Programs], followed by [Accessories]
and [Windows Explorer].
(With Windows 2000/Windows Me/Windows 98, right-click the
[My Computer] icon and select [Explore] from the popup
menu.)

2. Open the [Program] folder
inside the folder into which
ZoomBrowser EX 4 was
installed.
For example, open the folder to the
right if the following path is correct:
[C:\Program Files\Canon\ZoomBrowser
EX\Program].
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3. Double-click the [dbconverter.exe] or [dbconverter]
file in that folder.

4. Select the database file that was used with the
previous version of the program and click [Start].
For example, select the following database file if it was used
previously: [C: \Program Files\Canon\ZoomBrowser
EX\Database\My Database.zbd].

5. Click [OK] if the following dialog appears.

6. Click [Close] when the dialog in Step 4 appears.
This will display in ZoomBrowser EX 4 the titles and comments
input in version 2 or 3. The titles and comments will appear
together in the Comments section of ZoomBrowser EX 4.

Titles and comments input
in ZoomBrowser EX 2/3

Titles and comments as they appear
in ZoomBrowser EX 4
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■ Image Files Were Saved Below the Program Files
Folder in a Previous Version

In ZoomBrowser EX 4, image files in folders within the Program
Files folder will not display. To display these images, perform the
procedures below after you have followed steps 1-6 on the
previous page.

1. Use Windows Explorer to copy the image folders
within the Program Files folder and paste them in
another folder higher in the directory hierarchy.
For example, if a folder called the [Image Library One] folder is
in the Program Files folder, move it to a higher location, such as
the [C:\] drive.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Do not copy just the images from within the folder, copy the
folder itself to a location higher in the directory hierarchy.

When you select the copied folder in ZoomBrowser EX 4, the
images will now display.

Click the copied folder to display its images in the
Browsing Area.
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A Adding Computer Images to the Camera
71, 78
Adobe RGB color space  12, 23, 28
Auto-Download Settings  114

B Brightness  41
Browsing Area  22, 23, 32

Selecting Folders  31
Buttons

Browse & Download Images  8, 23
Camera & Memory Card  8, 23, 24, 65
Clear All  26
Close  18, 42
Connect to Internet  28
Delete  26, 29
Deselect  29
Download Image  28
Download image  66
Function Buttons  26, 29
Help  18, 29
Internet  24
Print  12, 24, 28
Properties  26, 29
Return to Main Menu  24
Rotate  26, 29, 52, 70
Save As  42
Select  29
Select All  26, 45
Set  29, 71
Task Buttons  24, 28
Thumbnail Size  26, 32
Up  26, 35
View & Modify  24

View as Slideshow  28
View Image  26, 37
View Mode  26, 32
Zoom-In  26
Zoom-Out  26

C Camera Settings  85
Camera Window  28, 64

Opening  64
Changing the Display  27
Close box  17
Color  41
Computer

Slide Show  82
Contrast  41
Copying Images  47
Crop  40
Customizing Menus  120

D Deleting
Camera Images  69
Folders  59
Images  50

Deselect Image  45
Display Mode  32
Displaying

Changing the Display  27
Images  37

Downloading Images  66
DPOF  122

E E-mail  76
Edit Panel  39
Editing

Images  39
Sounds  93

Events Dialog  5
Events dialog  124
Exif 2.2 (Exif Print)  17
Exit  18
Export  80
Exporting Images  80

F Finding
Folders  22, 61
Images  21

Folder
Creating  44
Deleting  59
Finding  61
Properties  61
Refreshing  58
Renaming  60
Selecting  31, 34

Folder Area  22, 23, 31
Selecting Folders  31

Format  72, 79, 113
Function Buttons

Camera Window  28, 29
Main Window  23, 26

H Help  18
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I Images
Adding Sounds  84
Adding to the Camera  71
Copying  47
Deleting  50
Deselecting  45
displaying  37
Downloading  8
Editing  39
Opening  37
Properties  62
Renaming  53
Rotating  52
Searching  55
Selecting  45
Sorting  54
Zooming  38

Index Print
DPOF  122

J JPEG Format  113

K Keywords  57

M Main Window  23
Menu

Customizing  120
Movies  68, 95

Editing  96
Exporting  100
Playing  95

Moving Images  46
My Camera Settings  86

Creating files  90
Saving to the Camera  92

My Camera Sound  93
My Camera Sound Maker  93
My Camera Window  86
My Pictures Folder  21

N New Folder  44

O Opening Images  37
Owner's Name  85

P PhotoCD format  113
PhotoRecord  13, 20
PhotoStitch  20, 111
Play Sound  84
Preferences  117
Preview Mode  33
Print Settings  122
Print/Share Button  10
Printing  12
Properties

Folder  61
Image  62

Q QuickTime Format  113
QuickTime Player  95

R RAW Format  68, 113
Converting  102

Reconnect  75
Recording Sounds  93
Redo  42
Remote Shooting  107

Interval Timer Shooting  109
Timer Shooting  109

Renaming
Folders  60
Images  53

Right-Click  30
Rotating

Camera Image  70
Images  52
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S Save As  42
Saving Images

CD-R/RW  112
Save As  42

Scroll Mode  33
Searching Images  55
Select All  45
Selecting

Display Mode  32
Images  45

Set Button  29, 71
Shooting Information  62
Slide Shows

Camera  121
Sorting Images  54
Sounds  84

File Length  90
Saving Sounds  94
Sound Memo  68

Standard Print  122, 123
Starting ZoomBrowser EX  4
Stitch Assist Mode  68, 111

T Task Area
Camera Window  28
Main Window  23, 24
Using the Task Windows  25

Task Buttons
Camera Window  28, 73
Main Window  24

Theme  87
Thumbnails  22
TIFF Format  113

U Undo  42

V Video clip files  113

W Window
Camera Window  28, 64
Main Window  7, 23
Switching  23

Windows Bitmap Format  113

Z Zoom In/Out  36
Zoom Mode  32
ZoomBrowser EX

Exiting  18
Starting  4

Zooming  38
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Disclaimer
• While every effort has been made to ensure that the information contained in this guide is accurate and complete, no liability

can be accepted for any errors or omissions. Canon reserves the right to change the specifications of the hardware and software
described herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language
in any form, by any means, without the prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a mistaken operation or malfunction of
the camera, the software, the CompactFlash™ cards (CF cards), personal computers, peripheral devices, or use of non-Canon CF
cards.

Trademark Acknowledgments
• Canon and PowerShot are trademarks of Canon Inc.
• Adobe and Photoshop are trademarks of Adobe Systems Incorporated.
• ArcSoft, the ArcSoft logo, ArcSoft PhotoStudio, ArcSoft PhotoImpression and ArcSoft VideoImpression are trademarks

or registered trademarks of ArcSoft, Inc.
• CompactFlash is a trademark of SanDisk Corporation.
• Quick Time is trademark of Apple Computer Inc., registered in the United States and other countries.
• Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States

and/or other countries. Microsoft® Windows® 98, Microsoft® Windows® 2000, Microsoft® Windows® Millenium Edition,
and Microsoft® Windows® XP are referred to in this guide, respectively, as Windows 98, Windows 2000, Windows Me,
and Windows XP, or as Windows.

• Netscape and Netscape Navigator are trademarks or registered trademarks of Netscape Communications Corporation in the United
States and other countries. Netscape Communicator is a trademark of Netscape Communications Corporation.

• Other names and products not mentioned above may be registered trademarks or trademarks of their respective companies.

© 2004 CANON INC.CDP-E029-010
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